Contents

Create a New Document .................................................................................................................. 2
  Class Walkthrough 2.1 .................................................................................................................. 2

Entering Text into a Document ......................................................................................................... 2
  Class Walkthrough 2.2 .................................................................................................................. 2

Lines of Text vs. Paragraphs ........................................................................................................... 2

Insertion Point .................................................................................................................................. 3

Word Wrap ........................................................................................................................................ 3

Remove Text ..................................................................................................................................... 3

Insert Text ......................................................................................................................................... 3

Undo/Redo/Repeat ............................................................................................................................. 3

Selecting Text .................................................................................................................................... 3
  Class Walkthrough 2.3 .................................................................................................................. 4
  Student Practice 2.4 ...................................................................................................................... 4

Moving Around in a Document .......................................................................................................... 5
  Class Walkthrough 2.5 .................................................................................................................. 5
  Student Practice 2.6 ...................................................................................................................... 6
  Student Practice 2.7 ...................................................................................................................... 7

Creating and Saving Files ................................................................................................................ 8
  Class Walkthrough 2.8 .................................................................................................................. 8
  Student Practice 2.9 ...................................................................................................................... 9

Saving documents between drives ................................................................................................. 10
  Student Practice 2.11 ................................................................................................................... 10

Using the Help feature .................................................................................................................... 11
  Class Walkthrough 2.12 ............................................................................................................... 11

On-Line Help ..................................................................................................................................... 11

Additional Help at the PRC .............................................................................................................. 12
  Student Practice 2.13 ................................................................................................................... 12

Extra Practice to do at home ............................................................................................................. 12
Create a New Document

Class Walkthrough 2.1

Instructor will walk through two ways to create a new blank document:

- Launch Word--a black document screen appears.
- Click the File Menu. Select New. Make sure Blank document is selected and hit the Enter key on the keyboard. Alternately, double click Blank document or with Blank document selected, click on Create (bottom right).

Entering Text into a Document

Class Walkthrough 2.2

1. Open Master Walkthrough
2. Display the paragraph markers by clicking the Show/Hide button on the Ribbon.
3. Follow the instructor’s prompts as the various document text entry elements are explained.
4. Minimize the document (leave open for the Student Exercise later).

Lines of Text vs. Paragraphs

If you simply type lines of text, the text will automatically wrap to the next line. However, if you press the Enter key on your keyboard anywhere in the text, it starts a new line and automatically creates a “paragraph.” A paragraph can be a single line, many lines, a bullet or numbered item, even a single word--as long as it is followed by the a paragraph marker set by the Enter key.

To view paragraph markers (so you can tell when paragraphs begin and end), click on the Show/Hide button.

Knowing the location of the paragraph markers is important when formatting and selecting text for copying, cutting or pasting. The paragraph marker at the end of a block of text holds the formatting.
Insertion Point

The vertical blinking line on the screen is called the *Insertion Point*. The insertion point indicates where text is typed, deleted, moved, etc. To place the Insertion Point, move the mouse to the location and single left click.

Word Wrap

When you type text that is more than one line, the text will automatically wrap to the next line. You don’t need to press *Enter*.

Remove Text

To delete text to the *RIGHT* of the Insertion Point, press the *Delete* key. To delete text to the *LEFT* of the insertion point, press the *Backspace* key.

Insert Text

The *Insertion Point* tells you where Microsoft Word will insert text. When you type, it moves the existing text to the right.

Undo/Redo/Repeat

To correct a mistake (or action), click on the *Undo* arrow in the Quick Access toolbar. This reverses the last action you performed. You can reverse many previous actions by continuing to click on the *Undo* button. If you determine you didn’t want to undo the last action, click the *Redo* arrow. The *Redo* can only be used if the *Undo* feature has been used. In other words, you can *Redo* only what you have undone with *Undo*. The *Repeat* arrow repeats the last action.

Selecting Text

There are many ways to select text—either using the mouse or the keyboard or a combination of both. You select text to:

1. delete text
2. modify the content of the text – replace the text with new text
3. change the format of the text - font, size, etc.
4. move or copy text.
Class Walkthrough 2.3

1. Open *Master Walkthrough*.
2. Use the selection methods below to select and remove text.

- To select any block of text, click and drag the mouse over the text
- To select a word, double click on it.
- To select a sentence, while holding the *Ctrl* key on the keyboard (bottom row, left or right), click anywhere in the sentence.
- To select a paragraph, click three times anywhere within the paragraph. Or, move the cursor to the left of a paragraph until it will become an arrow and double click.
- To select the entire document, click Select All on the right side of the Home tab of the Ribbon
- Place the insertion pointer at the starting location, navigate to the ending location in any manner, then hold down the shift key and left click at the end point.

Student Practice 2.4

1. Open Student Practice 2.4 (Shared Drive (S:)/Training Resources/Word 1/Week 2)
2. Follow the instructions for deleting words, lines, paragraphs and selected blocks of text.
3. When done, wait for instructor review.
Moving Around in a Document

You can use the mouse and/or keyboard functions to move easily and quickly in Word. The following Walkthrough demonstrates a series of shortcuts.

Class Walkthrough 2.5

1. Open *Master Walkthrough*
2. Use the up/down arrow keys to move to the previous and next lines.
3. Use the left/right arrow keys to move across text on a line.
4. Use the *Home* key to move to the beginning of the line. Use the *End* key to move to the end of the line.
5. Press *Ctrl + End* to move to the end of the document.
6. Press *Ctrl + Home* to move to the top of the document.
7. Place the insertion point in the second paragraph. Press *Ctrl + Up Arrow* to move to the previous paragraph.
8. Press *Ctrl + Down Arrow* to move to the next paragraph.
9. Use the *Page Up* and *Page Down* keys to scroll between screens.
10. Use the scroll bar to move the text up/down the screen, or practice using the scroll wheel on the mouse if you have one.
11. Use the double arrows at the bottom of the vertical scroll bar to move up or down 1 page per click.
12. Double click on the Page Number in the lower left corner of the task bar. Go to a different page. Try again going to a different page.
13. Practice using these navigation keys.
Student Practice 2.6

1. Open *Master Walkthrough*

2. Turn on the paragraph markers. Turn them off. Turn back on.

3. Go to the end of the document.

4. Type your name.

5. Go back to the top of the document. Type your name at the top of the page (above the title) and add an extra blank line after your name. (Hint: Type your name immediately before the word “Master” and then hit the *Enter* key.)

6. Go to the page which begins with “Changing Font Attributes” (should be page 5).

7. Type your name at the top of the page (above the title) and add an extra blank line after your name. (Hint: Type your name immediately before the word “Changing” and then hit the *Enter* key twice.)

8. How many pages are in this document? ___

9. Go back to the beginning of the document. Select a paragraph on this page

10. Delete it.

11. Undo the delete.

12. Select a sentence on this page.

13. Delete it.

14. Undo the delete.

15. When done, wait for instructor review.
Student Practice 2.7

1. Open Practice 2.7
2. Make the following changes so the document matches with the letter below.
3. When done, close the document. When asked to save the document, click No.

(enter today’s date here)

The Chicago Sun Times
100 Michigan Avenue
Chicago, IL 60601

Attn: Human Resources Department
Re: Job Code #9090

I read your ad for a CASHIER SUPERVISOR position in the Sun Times dated 4/10/04 and would like to apply for the job. I have several years experience in the retail business.

I would like to discuss my skills with you at your earliest convenience. I can be reached at (enter your phone number) after 7:00pm.

I look forward to your call.

Sincerely,

(enter your name)
(enter your street address)
(enter your City, State, Zip Code)
Creating and Saving Files

A document is also referred to as a file. When you save a file, you save it to a folder. Within a folder, you can have subfolders. Files are always stored in folders.

For this class, we will be saving all files to your Documents folder. By doing this, we keep the original documents intact.

Class Walkthrough 2.8

2. Instructor will walk through Save As.
   a. Only Save As creates a new document. You must use Save As the first time you save a new document.
   b. Save As allows you to establish three important things:
      i. The name of the document
      ii. Where the document will be stored
      iii. The type of document
   c. Save does not create a new document. It allows an existing document to be updated with the latest changes.
   d. Other uses of Save As:
      i. To save a copy of an existing document in a new place
      ii. To save a copy of an existing document with a new name
      iii. To save an existing document as a different document type

If you are creating a document from scratch and you use the save icon in the Quick Access toolbar, a Save As dialog will be generated. Subsequent use of the same icon will just do a Save. The Save and Save As commands are also available on the File tab of the Ribbon.

3. Type your name on the screen.
4. Save the document as Save1 in your Documents folder.
5. Close out of Word and find the file Save1 in your Documents folder. Notice that an extension of .docx has been added to your file name. This extension designates that the file was created in Word.
6. Create another new document in Word, type your address and save that as Save2 in your Documents folder.
7. The instructor will walkthrough opening files the Word 1 folder and saving to your Documents folder. Open Student Practice 2.4 from Module 2. Save it as Save4 in your Documents folder.
8. Repeat this with Student Practice 2.7.
Note: It is very important to know when to save over existing versions of a document. When you replace an existing document with Save, you are updating the information in the document with the new changes.

Student Practice 2.9

You are going to save 2 documents from Word 1\Week 4 to your Documents folder.

1. Access the Word 1\Week 4 folder
2. Locate Homework 4.1 and open it.
3. Click the File Tab/Save As. You will keep the name the same.
4. Navigate to your Documents folder and double click so your Documents folder is on the top in the Address bar at the top of the screen.
5. Click Save.
6. Repeat this for the Practice 4.2.
Saving documents between drives

The computer has several different drives from which you can copy, save, and retrieve files:

- **C**: The hard disk (the main drive)
- **D**: Typically the CD/DVD drive
- **other**: A flash drive (also called a jump drive or thumb drive) plugged into a USB port.

You can save or copy documents from one drive (i.e. C: drive) to another (i.e. E: drive).

Student Practice 2.11

1. Open **Welcome** from Word 1/Week 1 folder.
2. Save it to your Documents folder.
3. Enter your three goals for this class at the bottom of the page.
4. Save the file with a different name. In the File Name field, type **Course Goals** as the file name and save to your Documents folder. You should now have a **Welcome** document and a **Course Goals** document.
5. To verify, click File/Open. Open your Documents folder. Both documents should be listed.
Using the Help feature

There are several ways to get “help” or instructions on how to use MS Word. They are:

- Screen tips
- On-Line Help
- Additional Help at the PRC

Class Walkthrough 2.12

Open *Master Walkthrough*.

You can quickly find out a button function by placing the cursor on the button (on the Ribbon) and waiting for 2 seconds. A *Screen tip* appears with a description of the button.

On-Line Help

1. Click on Help (which is the question mark icon at the upper right-hand corner of the screen, under the red X (close icon)).

2. For example, type **indent a paragraph** and press Enter. Text in blue indicates that more information on that topic is available.

3. Click on one of the blue article titles to learn about the topic.

4. Continue to search on different topics. When done, click on *Close*. 
Additional Help at the PRC
Attend an Open Learning session at PRC. Ask your instructor for information on when and where these sessions are held.

Student Practice 2.13

1. Open *Master Walkthrough*.
2. Click on the Help (the question mark in the upper right-hand corner).
3. Search for the word *Save*.
4. Click on *Save a File* option.
   When done, close the *Help window*.

Extra Practice to do at home
Open Homework 2.1 in the Week 2 folder and follow the directions.